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With Laplink Switch & Sync, you can perform a migration to move files and folders 
from a PC to a Mac and also synchronize PC to Mac, Mac to Mac, or PC to PC. Transfer 
and synchronize your computers across a network, Laplink USB cable, or Laplink 
Ethernet cable.

Glossary
Host computer  The computer to which you will connect in a Switch & Sync 

session.
 When in a File Transfer window, the Host is the Remote computer 

or is called by its network name. When in a Synchronization 
window, the Host is Folder B. 

 Note: In a migration, when connecting to a Mac from a Windows 
PC, the Mac is always the Host.

Guest computer  The computer from which you will connect to the Host computer 
in a Switch & Sync session. 

  When in a File Transfer window, the Guest is the Local PC. When 
in a Synchronization window, the Guest is Folder A. 

 Note: In a migration, when connecting to a Mac from a Windows 
PC, the PC is always the Guest.

Synchronization  The procedure that copies the most recently changed version of a 
file from one folder to another. 

 The outcome of synchronization will depend on the direction of the 
transfer and the conflict resolution rules that you specify. 

Conflict A condition which occurs when you attempt to synchronize in the 
direction of a file that has changed since the last synchronization. 

 Switch & Sync will handle conflicts according to the rules that you 
specify in the synchronization job settings  (e.g., overwrite, keep, 
or copy the file) .

 Example: An initial synchronization of files from Folder A 
to Folder B is completed. A file that is part of the sync job is 
changed in Folder B. When the sync job is run again, this will 
create a conflict.

 

System Requirements (PC)
• Windows 7/Server 2008/Vista/Server 2003/Windows XP.

• RAM: Same as minimum required by operating system.

• Available hard disk space: 10 MB.

• Migrating PC e-mails to Mac: Outlook 2000 and later/Outlook Express 6 and 
later/Windows Mail.

• Migrating PC contacts/calendar items to Mac: Outlook 2000 and later.

IMPORTANT: When you purchase Switch & Sync, you are purchasing a license that 
limits you to installing the software on up to three (3) computers used by you. A valid 
license must be purchased for each person who will use the software. You cannot 
use your serial number to install Switch & Sync on a fourth (additional) computer. For 
complete details, refer to the End User License Agreement (EULA).

To purchase additional licenses, please visit http://www.laplink.com or contact our 
sales department at (800) LAPLINK (527-5465) or (425) 952-6001.

System Requirements (Mac)
• Mac OS X v10.5 Leopard and v10.6 Snow Leopard.

• CPU: Intel® processor.

• RAM: 512 MB.

• Available hard disk space: 6 MB.



h t t p : / / w w w . l a p l i n k . c o m / h e l p
E-mail us at CustomerService@laplink.com

2

Tel (USA):  +1 (425) 952-6001
Fax (USA): +1 (425) 952-6002

Tel (UK):  +44 (0) 870-2410-983
Fax (UK): +44 (0) 870-2410-984

User Guide Switch & Sync 

TM 

Installing Switch & Sync (PC)
IMPORTANT: You must install Switch & Sync on each computer on which you will 
use the application. For details on the maximum number of installations allowed, 
refer to the End User License Agreement.

IMPORTANT: Before installing or running Switch & Sync, exit all other applications 
running on your PC. 

Screen savers, hibernation protocols, and power-saving options should be turned 
OFF (i.e. All power management options in the Control Panel should be set to “Never” 
so they are completely disabled). The computer needs to remain on and completely 
“awake” during a transfer or synchronization and must not go into screensaver or 
sleep/hibernation mode.

To install Switch & Sync from a downloaded file, follow these steps on your 
computer:

1.  Double-click the switchandsync_en.exe file in the folder where the file was 
saved, and skip to Finish Installation.

To install Switch & Sync from a CD, follow these steps on your computer:

1.  Insert the CD into the CD-ROM drive.

2.  If the autorun feature is enabled, the installation begins automatically. Go to 
Finish Installation.

 If autorun is disabled, use Windows Explorer or some other file management 
program to display the contents of the CD. Browse to the  
switchandsync_en.exe file to begin the installation. If you cannot find this file 
on the CD, click Start, then Search, and type switchandsync_en.exe, making 
sure that the search is centered on your CD-ROM drive.

Finish Installation

1.  Check for an Updated Version

 

 Click Yes to check for an update.

 Note: If an update is available, you will be presented with a Web page. Please 
follow all instructions presented to download and install the update for 
Switch & Sync.

 Please make sure to download and install updates on BOTH the PC and the 
Mac.

2.   Welcome to the InstallShield Wizard for Switch & Sync 

 Click Next to proceed with installation. 

3.   License Agreement 

 Review the license agreement, select “I accept the terms in the license 
agreement”, and click Next to continue.

4.   Destination Folder

 By default, the program will install to:

 C:\Program Files\Laplink\SwitchAndSync\

 Alternatively, click Change and select or create a new destination folder. When 
finished, click Next.
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5.   Ready to Install the Program

 Click Install to begin the installation. Wait for the InstallShield Wizard to 
complete the process.

6.   InstallShield Wizard Completed

 To start Switch & Sync immediately after installation, select “Launch Switch 
& Sync” and click Finish to close the InstallShield Wizard. You can launch the 
application at any time by clicking Start, selecting All Programs (or Programs, 
depending on your settings), Laplink Switch & Sync, and Switch & Sync.

 Note: Before starting Switch & Sync, exit all other applications running on 
your PC.

Installing Switch & Sync (Mac)
IMPORTANT: Before installing or running Switch & Sync, quit all other applications 
running on your Mac. 

Screen savers, hibernation protocols, and power-saving options should be turned 
OFF. The Mac needs to remain on and completely “awake” during a transfer or 
synchronization and must not go into screensaver or sleep/hibernation mode. 

1.  Downloaded File: Double-click the SwitchAndSyncMacEn.dmg disk image to 
access the installer package. Then, double-click the SwitchAndSyncMac.pkg 
installer package to start the installation process, and continue to step 2.

 CD: Insert the Switch & Sync CD into the CD-ROM drive, and double-click the 
Switch & Sync CD icon on the desktop. 

 Once the CD opens, double-click the SwitchAndSyncMacEn.dmg disk image to 
access the installer package (the disk image is located in the root directory of 
the CD). Then, double-click the SwitchAndSyncMac.pkg installer package to 
start the installation process, and continue to step 2.

2.  Click Continue and follow the on-screen prompts. Then click Install to 
complete the installation.

3.  After installation is complete, navigate to your Applications folder and   
double-click SwitchAndSync to start the application.

Registration and Activation
1. Register Switch & Sync

 When you start Switch & Sync for the first time, you will be prompted to 
register the product. In Laplink Registration, type in the requested information 
and then click OK.

 IMPORTANT: First Name, Last Name, Company, and E-mail Address are 
required fields.

2. Activation - Serial Number Entry

 In the Serial Number dialog box, type your Switch & Sync serial number and 
click OK.

 The location of your serial number depends on how you purchased   
Switch & Sync:

• Download:  When you purchased the product, you should have received 
a confirmation e-mail containing your serial number. If you no longer 
have the e-mail message, visit the “My Downloads” page  of your 
Laplink Support Account at:

 http://www.laplink.com/mysupport/myStore.asp

 Once there, enter the e-mail address you supplied when you purchased 
the product.  If you have forgotten your password, please enter your  
e-mail address and click the Forgot Your Password link.

• CD: Serial label located on the CD sleeve or on inside of plastic case.

To complete serial number verification automatically for either type of 
purchase, you will have to be connected to the Internet on your PC. If you are 
connected to the Internet but are unable to validate the serial number, first 
disable all security software, such as virus scanning, spyware scanning, and 
firewalls, and try again.

If an Internet connection is not available to you, or if registration fails, please 
call our Customer Service team at (425) 952-6001.

Note: There is now a Mac registration. If you are upgrading from an existing 
version of Switch & Sync, you must enter your serial number on the Mac 
when prompted.



h t t p : / / w w w . l a p l i n k . c o m / h e l p
E-mail us at CustomerService@laplink.com

4

Tel (USA):  +1 (425) 952-6001
Fax (USA): +1 (425) 952-6002

Tel (UK):  +44 (0) 870-2410-983
Fax (UK): +44 (0) 870-2410-984

User Guide Switch & Sync 

TM 

Setting up This Computer - Authentication
When you first start Switch & Sync, the application will prompt you to set up a 
username and password for Guest computers connecting into your Host computer.

• Authentication: If you want Switch & Sync to require authentication, leave 
default “Yes, authentication is required” selected and create a unique 
username and password. Click OK when complete.

 Note: Both a username and password must be entered to continue with the 
default selection.

 Each computer on which you are installing Switch & Sync should have a 
unique username and password, which can be different from the computer’s 
log in credentials.

• No authentication (Open System): If you want to allow all Guest computers 
to connect to this Host computer without authentication, select “No, 
authentication is not required (Open System)” and click OK.

Switch or Sync (PC to Mac)
When you start Laplink Switch & Sync on the PC, you will see a beginning dialog 
window that gives you the option to Switch or Sync:

• Switch (migrate your files from your PC to your Mac): If you click this option,  
 Laplink Switch & Sync will open up the Migration wizard to assist you with  
 setting up the initial migration (copy) of files from your PC to your Mac. See  
 the Migration Wizard (PC to Mac) section on page 5.

• Sync (synchronize and transfer files): If you click this option,   
 Switch & Sync’s Main window will open. To synchronize or transfer your files,  
 start by creating a new connection (see the Connection Management section  
 on page 10).

 For an overview of the features and settings available from the Main window,  
 see page 9.
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Migration Wizard (PC to Mac)
The Migration Wizard is a tool to assist you with the initial migration (copy) of files 
from your PC to your Mac.

To start the Migration Wizard, choose Switch from the Switch or Sync dialog window 
when you first start Switch & Sync on the PC.

You can also start the Migration Wizard by clicking Switch To Mac in the Main window 
on the PC.

Note: If you don’t see the ‘Switch To Mac’ button listed, click ‘Main’ to return to the 
Main window. See page 9 for more information.

• Before going through the Wizard, make sure that Switch & Sync is running on 
the Mac. 

• Laplink USB Cable: If you wish to use a Laplink USB cable to make a 
connection, plug it into the USB port on both computers now. 

• Laplink Ethernet Cable: If you wish to use a Laplink Ethernet cable, plug it into 

the Ethernet port on both computers now. To access the Ethernet port, you may  
need to unplug your Internet cable.

1. Migration Wizard - Choose Connection Type

 

 Select the connection method that you wish to use.

• To connect over a Network or Laplink Ethernet cable, select Network or 
Laplink Ethernet Cable and go to step 2. 

• To connect over a Laplink USB cable, select Laplink USB Cable and go to 
step 3.
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2. Migration Wizard - Choose Host (Mac)

 

 Select the Mac to which you want to connect from the list and click Next. 

 If the Mac is not listed, click Refresh List. If the Mac still is not listed, select 
Specify a Switch & Sync Mac and type the IP address of the Mac into the field 
provided. 

 Note: If you do not know the IP address of the Mac, go to the Apple menu and 
click ‘System Preferences’. Then in ‘System Preferences’, go to the ‘View’ 
menu and click ‘Network’. In the Network window, click a Network port. 
If you are connected to that Network, you will see your IP address under 
‘Status’.

3.   Migration Wizard - Host Authentication

 

• If Switch & Sync on the Mac has been set up to require a username 
and password to accept a connection, leave the default Authentication 
selected and type in the username and password. 

• Otherwise, select Open System if the Mac does not require a username 
and password.  

 Then, click Test Connection. When the connection is successfully established, 
click Next.

 Note: If the connection fails, go to Switch & Sync on your Mac and then 
‘Incoming connection settings’. Make sure the ‘Start Host’ button has been 
clicked (‘Start Host’ should be grayed out).
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4.   Migration Wizard - Select Files / Folders

 

 By default, all files/folders in the list are selected to move to your Mac. Click 
on items in the list to deselect if desired. My Emails also includes contacts and 
calendar items.

 Click Run to begin migration (copy).

5.   Migration Complete - Convert E-mail

 

 Click OK at the end of migration. 

 You will then see instructions about e-mails, contacts, and calendar files that 
have been migrated to your Mac. These files must first be converted to a Mac 
format before they can be imported into your Mac’s e-mail application. Click 
Convert Migrated E-mail To Mac Format in the Switch & Sync Main window on 
your Mac. 

 For more information, see E-mail Format Conversion (next).

 Location of files on Mac: Your PC’s files have been copied to a new “Windows 
PC” subfolder under the similar Mac folder. You may move these files to different 
folders on your Mac as desired. Use the Mac Finder to access your folders.

 Note: All files will be organized by user and located under    
/Users/<user name>/.

 • My Documents: /Documents/Windows PC/

 • My Music: /Music/Windows PC/

 • My Pictures: /Pictures/Windows PC/

 • My Videos: /Movies/Windows PC/

 • Desktop Wallpaper: /Documents/Windows PC Wallpaper/

 • My Desktop Files: /Desktop/Windows PC/

 • Microsoft E-mails: /Library/Mail/Windows PC/<e-mail client name>/ (i.e.,  
 if you use Outlook on your PC, the file path on the Mac will be   
 /Library/Mail/Windows PC/Outlook/)
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E-mail Format Conversion
IMPORTANT: If you are migrating your Windows PC to a Mac with OS X Lion, you 
will need to complete some additional steps on your Mac prior to importing files.  
Details are included in this section.

If you migrated e-mails, Outlook contacts, and/or calendar items from your PC to 
your Mac, these e-mails, contacts, and calendar items must first be converted to a 
Mac format before they can be imported into your Mac’s e-mail program. 

In Switch & Sync’s Main window on your Mac, click Convert Migrated E-mail To Mac 
Format under Sync Settings / File Transfer to start the e-mail conversion:

Once the e-mail conversion has completed, you will see the E-mail Converter window, 
which lists the location of the converted e-mail, contact files, and calendar items.

Note: If you have additional e-mail, contact files, or calendar items to be converted 
that are not listed, click ‘Manual’ to locate and convert these files.

 

Then, import the e-mails, contacts, and calendar items into your Mac’s e-mail 
program, address book or calendar.

The location of the converted e-mails, contacts, and calendar items is listed in the ‘E-
mail Converter’ screen (see above). You may need to expand the dialog box to view the 
entire file path. 

Note to Mac OS X Lion customers:  The Library folder, which contains the converted 
items to import, is a hidden folder in OS X Lion. To make the Library folder and its 
contents available for import, follow these steps:

1.            Open Finder.

2.            From the file menu again, select Go > Go to Folder.

3.            Type ~/Library and click Go.

4.            If your View is not already set to Columns, select View > as Columns.

5.             With the Library folder now in view, drag and drop it into your Favorites. 
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6.            Complete the importation of converted files into your applicable Mac   
                application. 

These additional steps to view the contents of the Library folder are not required for 
Mac OS X v10.5 Leopard or v10.6 Snow Leopard.

• Importing E-mails: As an example, in Apple Mail, go to the File menu and click 
Import Mailboxes. Follow the on-screen instructions, making sure to select 
“mbox files” from the “Import data from:” list.

 Or, as a second example, in Outlook for Mac 2011, go to the File menu and click 
Import. Click Contacts or messages from a text file, and click the right arrow 
button. Then, click Import messages from an MBOX-format text file, and click 
the right arrow button. Follow the on-screen instructions.

 If you have a different e-mail program on your Mac than these examples, please 
see the user guide for that e-mail program for instructions on how to import 
MBOX-format e-mail files.

• Importing Contacts: As an example, in the Mac Address Book, go to the File 
menu and click Import, choosing to import a vCard.

 Or, if using Outlook for Mac 2011, open the Mac Finder and navigate to the location 
where the converted contacts were saved. In Outlook, at the bottom of the 
navigation pane, click Contacts. Drag the vCard file (i.e., file extension .vcf) from 
its current location to the Contacts item list in Outlook.

 If you have a different program on your Mac than these examples, please see the 
user guide for that program for instructions on how to import VCF-format contact 
files.

• Importing Calendar Items: As an example, in iCalendar, go to the File menu and 
choose Import and then Import again. Locate the calendar you want to import 
(i.e., .ics file extension), and then choose the calendar to which you want to add 
the events.

 Or, if using Outlook for Mac 2011, open the Mac Finder and navigate to the location 
where the converted calendar items were saved. In Outlook, at the bottom of 
the navigation pane, click Calendar. Drag the ICS calendar file from its current 
location to the Outlook Calendar grid or list.

 If you have a different program on your Mac than these examples, please see 
the user guide for that program for instructions on how to import ICS-format 
calendar files.

Overview of Main Window
When you first open Switch & Sync on the Mac, or when you open the application 
on the PC and choose Switch from the Switch or Sync dialog, you will see the Main 
window. 

Buttons on the Main window give access to the application’s features and settings:

1.            Synchronization: Set up a new sync job to synchronize files between two  
                computers. Once a sync job has been created, additional buttons will be  
                active, allowing you to run and schedule all sync jobs. See page 15 for   
                instructions on creating a sync job, or page 24 for further details on                 
                scheduling sync jobs.

2.            Synchronization Jobs: Once a sync job has been created, it will be listed     
                here. Clicking on the sync job will give new options under the Synchronization    
                pane. See Sync Job Options on page 19 for further details.

3.            Main Button: If a sync job is selected, click Main to return to the Main window            



h t t p : / / w w w . l a p l i n k . c o m / h e l p
E-mail us at CustomerService@laplink.com

10

Tel (USA):  +1 (425) 952-6001
Fax (USA): +1 (425) 952-6002

Tel (UK):  +44 (0) 870-2410-983
Fax (UK): +44 (0) 870-2410-984

User Guide Switch & Sync 

TM 

            (see above image), where you can create additional sync jobs, change application       
            settings, run file transfer, and other options. Until a sync job is present, the 
            Main button will remain disabled.

4.         Sync Settings/File Transfer

 • Connection and Sync Settings: You can change the settings for   
 connecting to this Host computer in Incoming Connection Settings  
 and change the defaults for new sync jobs in Default Sync Job Settings.  
 See Synchronization Settings on page 26 for more information.

  In Connection Management, create a new connection to the Host  
 computer, which is needed to run a sync job or perform a file transfer.  
 See the next section for further instructions.

 • File Transfer: Click and drag files from one computer to the other using  
 the dual-pane file transfer window. See Transferring Files on page 13 for  
 further instructions.

 • Switch To Mac: Migrate files and folders from your PC to your Mac using  
 the Migration Wizard. See Migration Wizard (PC to Mac) on page 5 for  
 further instructions.

5.         Recent Events: Once a synchronization has been run, a summary of the results            
            will be listed here. If a sync job is selected, this pane will list details about the        
            sync job.

Connection Management
To transfer or synchronize files between computers, you must first create a new 
connection to the Host computer.

• Make sure that Switch & Sync is running on the Host computer (the   
computer to which you will connect). 

• Laplink USB Cable: If you wish to use a Laplink USB cable to make a 
connection, plug it into the USB port on both computers now. 

• Laplink Ethernet Cable: If you wish to use a Laplink Ethernet cable, plug it into 
the Ethernet port on both computers now. To access the Ethernet port, you 
may need to unplug your Internet cable.

1. Under Sync Settings / File Transfer, click Connection Management.

 Note: If you don’t see the ‘Connection Management’ button listed, click ‘Main’ 
to return to the Main window. See page 9 for more information.
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2. Define a New Connection

 
 In the lower left corner of the window, select the type of connection you want 

to create and click Create New Connection. 

• To connect over a Network or Laplink Ethernet cable, select Network 
or Laplink Ethernet Cable and go to step 3. 

• To connect over a Laplink USB cable, select Laplink USB Cable and go 
to step 4.

3.   Create New Connection - Host Tab

 Select the computer to which you want to connect from the list and click 
Next. 

 If the computer is not listed, click Refresh List. If the computer still is not 
listed, select Specify a Switch & Sync Host and type the IP address of the 
Host computer into the field provided. 

 Note: If you are connecting to a Mac and do not know the IP address of the 
Mac, go to the Apple menu and click ‘System Preferences’. Then in ‘System 
Preferences’, go to the ‘View’ menu and click ‘Network’. In the Network 
window, click a Network port. If you are connected to that Network, you 
will see your IP address under ‘Status’.

 If you are connecting to a PC and do not know the IP address, from the 
Windows Start menu on the Host PC, click ‘Run’ and enter “CMD”. At the 
DOS prompt, type “IPCONFIG” and press ‘Enter’. 

 On Windows Vista or Windows 7, hold down the Windows key and tap ‘R’ to 
access the “Run” screen.
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4.   Create New Connection - Authentication Tab

 

 If the Switch & Sync Host computer has been set up to require a username  
 and password to accept a connection, leave the default Authentication  
 selected and type in the username and password. If the Host computer does  
 not require a username and password, select Open  System.

 Then, click Test Connection. When the connection is successfully   
 established, click OK.

 Note: If the connection fails, go to your Host computer and then   
 ‘Incoming connection settings’. Make sure the ‘Start Host’ button has  
 been clicked (‘Start Host’ should be grayed out).

 

5.   Click Done in the Connection Management window. 

 After you have created a connection to a computer, it will be saved. The saved 
connection will be available for you to use in transferring or synchronizing 
files.

 Note: To transfer files, continue with the ‘Transferring Files’ section (next). 
To synchronize, continue with ‘Creating a New Sync Job’ on page 15.

Transferring Files and Synchronizing Folders
Switch & Sync offers two ways to move files from one computer to another:

• File Transfer: Manually move or copy files and folders from one computer to 
another.

• Synchronization: Configuring the computers to move the files and folders 
around, sometimes one way, sometimes both, as well as establishing rules for 
how duplicate or conflicting files should be handled.

The following sections describe these functions in more detail.
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Transferring Files
1. In the Main window, click File Transfer under Sync Settings / File Transfer. 

 Note: If you don’t see the ‘File Transfer’ button listed, click ‘Main’ to return to 
the Main window. See page 9 for more information.

 In the window that appears, you will be prompted to either select an already 
established connection or you can set up a new connection:

 

If you need to set up a new connection, select the connection type and click 
Create New Connection. Then follow the steps in the Connection Management 
section. If creating a Network or Laplink Ethernet cable connection, start with 
step 3 on page 11. If creating a Laplink USB cable connection, start with step 4 
on page 12.

Once you have selected a connection, click Go and the File Transfer window will 
appear: 

2. Navigate to Files / Folders

 The left pane, called “Local Machine”, is the Guest computer. The right pane 
shows the files and directories of the Host computer. 

 Use the left side of each pane to navigate through the folders on each computer. 
To prepare for the file transfer, open both the source folder and the target 
folder. 

3.   Select Files for Transfer

 On the right side of either pane, left-click on a file or folder you wish to transfer. 
To transfer several items at a time, left-click on each item while holding the 
CONTROL key if on a PC, or the Apple key if on a Mac. 
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4.   Transfer Files

• Copy: To copy the files, hold the left button of the mouse and drag the 
items as shown, from the right side of the source pane to the right side of 
the target pane:

 

• Move: To move the files (so the file is only on the target computer after 
transfer), right-click on the source files and choose Move.  Then right-
click on the right side of the target pane and choose Paste.

 On a Mac, if you don’t have the option on your mouse to right-click, hold 
the Control key and left-click to bring up the menu.

 Note: Files can be transferred in either direction, from Guest to Host or Host 
to Guest.

 

Synchronizing Folders
Switch & Sync allows you to automatically synchronize the contents of two folders 
located on the same or on different computers. Features include:

•  One-way and two-way synchronization: Copy the changed files from one folder 
to the other, or copy the files from each folder to the other.

•  File conflict resolution according to the rules set by the user: Set the rules 
for synchronizing the folders in which one or both matching files have changed 
since the last synchronization.

 •  Synchronization scheduled by the user: Set the day and time to repeat a 
synchronization job automatically.

• Smart synchronization: If following a synchronization, you replace a file with 
its older version in one of the folders, Switch & Sync will not simply replace it 
with the newer file version from the other folder. When editing the sync job, you 
can choose for Switch & Sync to automatically skip, copy the newer version, or 
to overwrite the file when dealing with such conflicts. You can also choose to 
resolve conflicts manually from the Preview Sync Jobs window.
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Creating a New Sync Job
1.   In the Main window, click on Create New Sync Job. 

 Note: If you don’t see the ‘Create New Sync Job’ button listed, click ‘Main’ to 
return to the Main window. See page 9 for more information.

 

 

2.  Creating Sync Jobs - Switch & Sync Host Tab 

 Note: At the top of this window, you will see two icons. These icons represent 
different views for creating a new sync job. The default view (left icon) is 
explained in this section. If you prefer the alternate view (the icon on the 
right), please proceed to ‘Creating a New Sync Job (Alternate View)’ on page 
17.

 In the new window, choose if you will connect via Network, Laplink Ethernet 
Cable, or Laplink USB Cable. Then, select a previously defined connection from 
the drop-down menu.

 

 Note: If you want to synchronize between two folders on the computer that 
you are currently using, choose ‘Local Drive’. A local connection is already set 
up for you.

 If you have not already established a connection to a Host computer, select the 
connection type and click Create New Connection. Then follow the steps in the 
Connection Management section. If creating a Network or Laplink Ethernet 
cable connection, start with step 3 on page 11. If creating a Laplink USB cable 
connection, start with step 4 on page 12. 
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 When you have established a connection, click Next. 

3.   Creating Sync Jobs - Directories Tab 

 

 Click Select Folder A and Select Folder B and navigate to find the folder from 
each computer that you wish to synchronize.  

 Click Next.

 

4.   Creating Sync Jobs - Direction Tab

 

 Specify the direction of synchronization. 

 Click OK.
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5. Name your New Sync Job

 

 You will be prompted to name your new sync job. Enter a unique name and  
click OK.

 Congratulations! You have successfully created a new sync job. 

 IMPORTANT: If you followed steps 1-5 and created a new sync job, continue to 
the section ‘Sync Job Options’ on page 19. Do NOT continue with ‘Creating a 
New Sync Job (Alternate View)’.

Creating a New Sync Job (Alternate View)
IMPORTANT: If you followed steps 1-5 and created a new sync job, continue to the 
section ‘Sync Job Options’ on page 19.

1.  Select the Alternate View

 In the Main window, click Create New Sync Job. 

 At the top of the new window, click the Alternate View icon. 
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2. Select a Connection

 In the new window, select how you want to connect in the Connect Over menu. 
Then, select a previously defined connection from the drop-down menu and 
click Go:

 

 If you have not already established a connection to a Host computer, select 
the connection type and Create New and click Go. Then follow the steps in the 
Connection Management section. If creating a Network or Laplink Ethernet 
cable connection, start with step 3 on page 11. If creating a Laplink USB cable 
connection, start with step 4 on page 12. 

 

 

3. Choose the Folders

 Once you are connected to the Host, double-click the folder on the Local 
computer (Guest) you would like to sync. This folder will now appear under 
Folder A in the middle pane:

 

 Now double-click the folder you would like to sync on the Host computer (the 
right pane) and it will appear under Folder B in the middle pane. 
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4. Specify the Synchronization Direction

 In the middle pane, choose the direction of the synchronization. 

5. Name the Sync Job

 Once you have selected the folders and direction of the synchronization, choose 
a unique name for your sync job in the middle pane and click Save.

 Once you have saved the new sync job, click Exit.  

 Congratulations! You have successfully created a new sync job. 

Sync Job Options
After you have created a new sync job, it will be selected on the Main window. If 
desired, click on a different sync job to select it:

When a sync job is selected, you will have new options under the Synchronization 
pane.

•  Rename Sync Job: Click Rename Sync Job and type the new name in the text 
box. Then click Rename Sync Job again to return to the Main window.

•  Delete Sync Job: Click Delete Sync Job and click Yes to confirm deletion.

•  Edit / Preview / Run Sync Job: Click the applicable button and follow the 
instructions in the following sections to perform these actions.
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Editing a Sync Job 

Select the sync job, and then click Edit Sync Job to make changes to how files and 
folders will be handled in the synchronization. The option to schedule the sync job is 
also given. 

Note: If you just want to schedule one or more of your sync jobs and don’t need to 
make any other edits, see Scheduling Sync Jobs on page 24.

1. Edit Sync Job - Files

 a. Click Folder A or Folder B to edit the folders you wish to    
 synchronize.

 b. If desired, choose to synchronize only certain file types by including or   
 excluding certain file types:

 Note: To include or exclude specific file types, type the extension in the 
appropriate box. Separate file types with a semi-colon. 

 Listing file types in the ‘Files to include’ box will result in only these    
file types being included in the synchronization. 

c. At the bottom of the Files dialog, you have the following options:

 

 • Include only matched pair: By selecting this option, you tell   
 Switch & Sync to ignore any files that do not have matching files in  
 the other folder. This means that if you create a file on one   
 computer, it will not synchronize to the other computer unless the  
 same file is there.

• Include subfolders: Keep this option selected to use the current 
job’s synchronization rules on the subfolders within the primary 
folders. 

• Include previously skipped files: If you have previously 
synchronized this folder pair and chose to skip certain files 
because of a conflict, selecting this option will apply the 
synchronization rules to these files and will try to synchronize 
them again. Therefore, you should resolve the conflict before 
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synchronizing these files.

 Note: To resolve conflicts, preview the sync job and click ‘Resolve 
Conflicts’ in the ‘Preview’ window. You will not be prompted 
during the synchronization to resolve conflicts.

 See ‘Previewing a Sync Job’ on page 22 for more information.

• Include files with attribute...: These options (PC only) allow 
 Switch & Sync to include hidden, system, or read-only attributes. 

These attributes are those you can check in Windows by right-
clicking a file and left-clicking Properties.

  When ready, click Next. 

2. Edit Sync Job - Direction 

 

 Edit the direction of synchronization if desired. Click Next when ready.

3. Edit Sync Job - Conflict Resolution

 In this dialog, you may choose to change how conflicts are handled: 

 

 If you are running a synchronization job for the first time, you will not see any 
conflicts. However, if you have run the job before and then make changes to the 
files in the destination of the sync job, conflicts may arise.

 Example: An initial synchronization of files from Folder A to Folder B is 
completed. A file that is part of the sync job is changed in Folder B. When the 
sync job is run again, this will create a conflict.

 The default for Conflict Resolution is Always check with user, which allows 
you to choose what to do about each conflict when previewing the sync job. The 
other selections will handle the conflicts automatically without giving the option 
for user choice. 

 Make any changes as needed to how conflicts are handled. Click Next when 
ready.
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4. Edit Sync Job - Scheduling

 

In the Scheduler dialog, select:

• Prescheduled to specify the day and time for Switch & Sync to repeat this 
job automatically. In the Username and Password text boxes, type in the 
name and password required to log in to your computer.

• Manual if you do not wish to repeat the job automatically. 

 Note: Laplink Scheduler uses Windows Task Scheduler, which can be 
used on a PC to configure more scheduling options. For more details, 
please see Windows Help.

Click OK to save all the sync job edits.

Previewing a Sync Job
Before you run your sync job, you have the option to preview all of the changes that 
will be made. 

Select the sync job you wish to preview, and click Preview Sync Job under the 
Synchronization pane. 

The new window will list all the items that will be synchronized:

You have the option to preview specific sync job changes, edit the sync job, resolve 
conflicts, and run the sync job.

• Preview and Total Counts: By default, all changes that will take place as a   
 result of the sync job are displayed in the list. To selectively view only certain   
 kinds of changes, select from the check boxes and click Update Preview.

• Edit Sync Job: Click Edit Sync Job and then follow the steps in Editing a Sync   
 Job on page 20.
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• Resolve Conflicts: If you are running a synchronization job for the first time,   
 you will not see any conflicts. However, if you have run the job before and   
 then make changes to the files in the destination of the sync job, conflicts   
 may arise.

 Example: An initial synchronization of files from Folder A to Folder B is   
 completed. A file that is part of the sync job is changed in Folder B.   
 When the sync job is run again, this will create a conflict.

 Conflicts are indicated in the preview by a red exclamation point symbol.

 If you have chosen to “Always check with user” as the way to deal with   
 conflicts, then resolve conflicts as follows: 

 (i)  Click Resolve Conflicts. 

 (ii)  In Resolving Conflict, specify the rules for resolving the conflict, and  
  click Next to continue to the next conflict. Repeat until you can no   
  longer click Next, then click OK. After you complete this step, you   
  should no longer see the conflict sign for any file pair.

 Note: If you do not resolve conflicts that are listed in the ‘Preview’ window,   
 these files will be skipped and not included in the synchronization. You will   
 not have an option to resolve conflicts while running the sync job.

• Run Sync Job: Click Run Sync Job and then follow the steps in Running a   
 Sync Job starting with step 2 on page 24.

Running a Sync Job
Under the Synchronization Jobs pane, select the sync job you want to run:

When a sync job is selected, you will have new options under the Synchronization
pane. 

1.  Click Run Sync Job. 
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2.  A new window will show the progress of the sync job:

 

3.  After the sync job is completed, a new window will appear with a summary of all 
 actions taken by Switch & Sync:

 

Scheduling Sync Jobs
To schedule one or more of your sync jobs to run unattended at a prescheduled time, 
click Schedule Sync Jobs under Synchronization in the Main window:

Note: If you don’t see the ‘Schedule Sync Jobs’ button listed, click ‘Main’ to return to 
the Main window. See page 9 for more information.

1. The window that appears will show a list of all your sync jobs. 

 Select the sync job in the list that you want to schedule. Then right-click on   
 the sync job and choose Schedule.

 Note: On a Mac, if you don’t have the option on your mouse to right-click,   
 hold the Control  key, left-click on the sync job and choose ‘Schedule’.
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2. In the window that appears, set up the schedule for the sync job:

 

 Choose Prescheduled. 

 Then specify the day and time for Switch & Sync to repeat the sync job   
 automatically.

 In the Username and Password text boxes, type in the name and password   
 required to log in to your computer.

 Click OK to save the schedule.

 Note: Laplink Scheduler uses Windows Task Scheduler, which can be   
 used on a PC to configure more scheduling options. For more details, please  
 see Windows Help.

Sync Job Log Files
To access the log files for a sync job that has been run, click on the sync job to select 
it and then click Log Files under Sync Settings / Files Transfer:
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The log files window displays the synchronized files and other information for a 
specific sync job. If a sync job has been run more than once, choose which log file to 
view by selecting the date/time from the list:

Synchronization Settings
You can change the settings for connecting to this Host computer and also change the 
defaults for new sync jobs.

These settings are accessible under Sync Settings / File Transfer:  

Incoming Connection Settings

In the Main window, click Incoming Connection Settings under Sync Settings / File 
Transfer.

Note: If you don’t see the ‘Incoming Connection Settings’ button listed, click ‘Main’ 
to return to the Main window. See page 9 for more information.
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Change the settings for connecting to this Host computer:

• Authentication Options: When you first started Switch & Sync, you chose   
 whether to require authentication for Guest computers connecting    
 to this Host computer. Change this setting here if desired.

 If choosing authentication, enter a unique username and password.

 Note: Each computer should have a unique username and password, which   
 can be different from the computer’s log in credentials.

• Incoming Connections: By default, the Host is started when you start   
 Switch & Sync, which allows Guest computers to connect to this Host   
 computer. Change this if desired.

 By default, Guest computers are allowed to connect using both    
 Network/Laplink Ethernet cable and Laplink USB Cable options. Change this   
 if desired.

• Start Host: The Host allows Guest computers to connect to this Host   
 computer. Click Start Host if not already started. 

Default Sync Job Settings

In the Main window, click Default Sync Job Settings under Sync Settings / File 
Transfer and make changes to the default settings that will be used for a new sync 
job:

Note: If you don’t see the ‘Default Sync Job Settings’ button listed, click ‘Main’ to 
return to the Main window. See page 9 for more information.

Note: You still have the option to make changes to these defaults in individual sync 
jobs when creating a new job or editing a job.

• Sync Direction: Choose the direction of synchronization. “Folder A -> Folder  
 B” and “Folder A <- Folder B” sync in one direction. “Folder A <-> Folder   
 B” syncs in both directions.

• Conflict Resolution: Select how conflicts are handled. Always check with   
 user allows you to choose what to do about each conflict when previewing the  
 sync job. The other selections will handle the conflicts automatically without   
 giving the option for user choice. 
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• Include (types of files and folders): Select the types of files you want to   
 include in the synchronization.

 • Include only matched pair: By selecting this option, you tell   
  Switch & Sync to ignore any files that do not have matching files in   
  the other folder. This means that if you create a file on one computer,  
  it will not synchronize to the other computer unless the same file is   
  there.

 • Include subfolders: Keep this option selected to use the current   
  job’s synchronization rules on the subfolders within the primary   
  folders. 

 • Include previously skipped files: If you have previously synchronized  
  this folder pair and chose to skip certain files because of a conflict,   
  selecting this option will apply the synchronization rules to these   
  files and will try to synchronize them again. Therefore, you should   
  resolve the conflict before synchronizing these files.

  Note: To resolve conflicts, preview the sync job and click    
  ‘Resolve Conflicts’ in the ‘Preview’ window. You will not be   
  prompted during the synchronization to resolve conflicts.

 • Include files with attribute...: These options (PC only) allow    
  Switch & Sync to include hidden, system, or read-only attributes.   
  These attributes are those you can check in Windows by right-clicking   
  a file and left-clicking Properties.

• File Filters: Choose to synchronize only certain file types by including   
 or excluding certain file types. To include or exclude specific file types, type   
 the extension in the appropriate box. Separate file types with a semi-colon.

 Note: Listing file types in the ‘Files to include’ box will result in only these   
 file types being included in the synchronization.  

Feedback and Support
We invite your comments on how well Switch & Sync performed. Please feel free to 
contact us at:

feedback@laplink.com

Live Chat - Engage in a live chat online with a Customer Service or Technical Support 
Representative at the link below, during the hours listed on the Web page:

http://www.laplink.com/contact/mychat.html

E-mail: CustomerService@laplink.com


